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ACE Write-Up to 
Creative Solutions Accounting 

Conversion Guide 
 

The ACE-CSA Conversion Wizard is provided to convert your client data from ACE Write-Up Version 4.xx and above into 
the Write-Up Solution bundle of modules within CSA. This conversion guide explains the necessary steps to convert your 
data, to identify the fields that will not be converted, and to document exceptions that you may encounter during the 
conversion process. The last section of this document explains the steps you should take to verify that the converted data is 
correct. 

Please review this document in its entirety before actually beginning the conversion process for a client. Refer to this 
document for all information regarding this conversion. 

CONVERSION PROGRAM OVERVIEW 
The overall objective of the ACE Write-Up to CSA conversion utility is to provide a comprehensive conversion of your ACE 
data to CSA. However, due to differences in processing calculations and data structures between ACE and CSA, some ACE 
data cannot be converted. Therefore, you should not expect to exactly duplicate results from ACE using the converted 
data without adding or modifying the appropriate data in CSA. The specific items that cannot be converted and 
conversion exceptions are listed in the section of this document entitled �Conversion Notes and Exceptions.� 

Note: If you process After-the-Fact Payroll in ACE Write-Up, you can convert employee current-quarter and year-to-
date balances for W-2 processing. For this reason, you should convert after finishing the payroll processing for a 
quarter or at year-end. For more information regarding the conversion of payroll amounts, please refer to the section of 
this document entitled �Items Transferred during Conversion of Data from ACE Write-Up.� Also, refer to the section 
entitled �Required Processing Step Prior to Running the ACE-CSA Conversion Wizard� on page 2 for further 
information on transactions. 

INSTALLING THE ACE-CSA CONVERSION WIZARD 
You must install the ACE-CSA Conversion Wizard prior to running the ACE-CSA Conversion Export Program, 
explained in this document. Follow the steps below to install the ACE-CSA Conversion Wizard. 
1. Insert the CSA Conversion CD version 2002.2 into the CD-ROM drive on your computer. 
2. In the Windows Taskbar, click the Start button and choose Run. 
3. Enter the command d:\SETUP (where d represents the letter of the CD-ROM drive that contains the conversion 

CD). 
4. If Microsoft Access 2000 is currently installed on your machine: In the Run dialog, type d:\ACE2000\SETUP 

(where d represents the letter of the CD-ROM drive).  
5. Follow the prompts as they are displayed on the screen while the ACE-CSA Conversion Wizard install program is 

running. 

REQUIRED PROCESSING STEP PRIOR TO RUNNING THE ACE-
CSA CONVERSION WIZARD 

The ACE-CSA Conversion Wizard assumes that you have closed out the processing period for the client in ACE and 
that you will be processing the next period�s transactions in CSA. If you have begun a new processing period in ACE 
for a client, you should not run the conversion until you have posted all transactions for that period and moved to the 
next period. For example, if you are processing November for client XYZ, you should close out the November period 
in ACE and then convert to CSA prior to entering any December transactions. This will eliminate any need for double 
posting of transactions. 
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CREATING THE ACE WRITE-UP EXPORT FILES 
After installing the ACE-CSA Conversion Wizard, use the following steps to create the ACE Write-Up export files. The 
export file layout is a specially formatted file that CSA can use to import your data. The conversion program does not 
change your original data in any way. 
1. To start the ACE-CSA Conversion Wizard, click the Start button on the Windows Taskbar, choose Programs / ACE-

CSA Conversion Wizard, and then click the ACE�CSA Conversion Wizard icon. 
2. Click Next. 
3. Enter the path to the ACE Write-Up client data you wish to convert to CSA.  

For example, if your ACE Write-Up data is on drive C and you want to convert client 55555, you would type: 
C:\ACE\Writeup\data\55555\. Each client is stored in its own subdirectory in the ACE\WriteUp\data folder. The 
name of the subdirectory is always the 5 digits of the client ID. Note, however, that if the client ID less than 5 
characters long, the five-character subdirectory will be preceded by zeros in the subdirectory name, such as 00015. 

4. Click Next. 
5. Enter the client�s ACE period number (0-12) for the last period that was closed. This does not represent the month 

number (i.e., January = 1). Instead, it represents the period number starting with 0 for beginning balances only, 1 
for the 1st period, 2 for the 2nd period, etc. For example, if the client has a 10/31/98 year end and you have 
completed June and moved to July, the last closed period number you enter would be 8 (June = 8 for a 10/31/?? 
year end). If the client is a quarterly processor, the 2nd quarter would be the 6th period, 3rd quarter would be period 
9, etc. 

6. Click Next. 
7. If appropriate, mark one of the checkboxes, as follows: 

• If you wish to have the account numbers convert exactly has they appear in ACE Write-Up, leave both 
checkboxes unmarked. 

• If you do not wish to convert the digits to the right of decimal in the ACE account number, mark the Do not 
convert� checkbox. 

• If the digits to the right of the decimal point in the ACE account number represent a profit center, mark the 
Profit Center� checkbox. 

8. Click Next. 
9. The next screen allows the conversion wizard to determine the account type for each asset. This screen will require 

you to select an account type for each account number range starting with 1 up to 9. If the accounts that start with 
the number 1 are assets, you should identify them by selecting A in the Account Type column. Allowable account 
types are A for Assets, L for Liabilities and Equity, R for Revenues, and E for Expenses. If you wish, you may 
accept the ACE-CSA Conversion Wizard defaults and then, for any accounts that do not match the conversion 
defaults, change the account types after importing the converted clients into CSA. 

10. Click Next. 
11. If you process payroll for the client, the next screen allows you to translate ACE Write-Up payroll codes into CSA 

payroll codes. The first column on this screen has the payroll codes used for the client in ACE-Write-Up. The 
second column has a matching field with a drop-down list to select the appropriate CSA payroll code. To translate 
an ACE pay code to CSA, simply click the corresponding CSA field and select a CSA pay type. The conversion 
program will then put the amount associated with this pay code for each employee into the appropriate CSA pay or 
withholding field. You should not translate the net pay field. It has no corresponding field in CSA. Likewise, if you 
do not use the code GROSS to accumulate the gross pay for employees, you should not translate this code to CSA. 
Note: If you do not have employees for the current client, this step will be skipped automatically.  

12. Click Next to start the actual conversion process. 
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IMPORTING THE CONVERTED FILES INTO CSA 
Use the following steps to import an ACE Write-Up client into CSA.  

1. Start the CSA program by clicking the desktop icon for Creative Solutions Accounting. 
2. Create a new client in CSA by choosing New Client from the File menu. (For more information on creating a new 

client, choose CSA Help Topics from the Help menu and then; in the Index tab of the Help dialog, choose New 
Client [File menu]. 

 
Note: When you create the new CSA client, you must specify the current fiscal year-end date (on the General 
Ledger tab of the File / New Client dialog or the File / Client Properties dialog) exactly as it appears for the client 
in your ACE Write-Up system. However, the current period ending date (also on the General Ledger tab) must 
be entered to match the last GL period closed in ACE Write-Up. 
 
If you are also converting payroll information, you will need to use Payroll Compliance Solution module as well as 
the General Ledger Solution module when adding the client in CSA, and you will also need to specify the current 
payroll end date (on the Payroll tab) to match the last payroll period closed in ACE Write-Up.  

 
3. From the Utilities menu, choose Data Conversion / ACE Write-Up. 
4. In the first field of the ACE Write-Up dialog, enter the location of the ACE Write-Up data files that you wish to 

import into CSA. This will be the same directory you entered in Step 3 of the section above entitled �Creating the 
ACE Write-Up Export Files.� 

5. The 5-character code �ACEWU� will be displayed in the Client to import field. This code is used to identify the 
converted files that are to be imported for this client. 

6. If you wish to convert the employee earnings totals, mark the Convert Employee Earnings checkbox. 
7. Click the Import button. 
8. Once the import has finished, you should make the necessary changes or corrections to the converted data as 

specified in the sections of this document entitled �Items Transferred during Conversion of Data from ACE 
Write-Up� and �Conversion Notes and Exceptions.� 

ITEMS TRANSFERRED DURING CONVERSION  
OF DATA FROM ACE WRITE-UP 

The following tables are provided to identify fields in ACE Write-Up that will be converted to CSA. The tables are 
organized by screens in ACE Write-Up and CSA and denote the necessary CSA screen navigation. 

General Ledger Account Information 
ACE Write-Up 
Field Name 

CSA Menu Navigation 
CSA Field Name 

Comments and additional information  

Account Setup / Chart of Accounts 
Acct# 

See Conversion Notes and Exceptions for more information 
on the conversion of the account numbers 

Description Setup / Chart of Accounts 
Description 

The description in CSA is 29 characters in length. The 
description in ACE is 32 characters in length. Only the 1st 29 
characters will be converted. 

This Year 
 

Setup / Chart of Accounts 
Balance 

 

Last Year Setup / Chart of Accounts 
Balance 

 

2 Years Ago Setup / Chart of Accounts 
Balance 

 

3 Years Ago Setup / Chart of Accounts 
Balance 
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GL Transactions  
ACE Write-Up 
Field Name 

CSA Menu Navigation 
CSA Field Name 

Comments and additional information  

No. Tasks / Transaction Entry 
Reference  

ACE did not require a reference number to be entered for a 
transaction. CSA requires a reference number. If no reference 
was entered in ACE, a reference number �1� was added to 
each blank transaction. This is required for the transaction to 
appear on the CSA General Ledger Report. 

Date Tasks / Transaction Entry 
Transaction Date 

 

Account  Tasks / Transaction Entry 
Account Number 

See Conversion Notes and Exceptions for more information 
on the chart of accounts mask. 

Description Tasks / Transaction Entry 
Description 

The transaction descriptions in ACE are 120 characters in 
length. CSA allows a transaction description of 110 
characters. Only the 1st 110 characters will be converted.  
If you entered quotes in the transaction description in ACE, 
the quotes have been removed prior to importing the data into 
CSA. 

Amount Tasks / Transaction Entry 
Amount 

 

Employee Information 
ACE Write-Up 
Field Name 

CSA Menu Navigation 
CSA tab 
CSA Field Name 

Comments and additional information 

Employee ID Setup / Employees 
General tab 
ID 

 

First Name Setup / Employees 
General tab 
First 

 

M.I. Setup / Employees 
General tab 
MI  

 

Last Name Setup / Employees 
General tab 
Last  

 

Address Setup / Employees 
General tab 
Street 

 

City Setup / Employees 
General tab 
City 

 

State Setup / Employees 
General tab 
State 

 

ZIP Code Setup / Employees 
General tab 
Zip 

 

Soc. Sec. # Setup / Employees 
General tab 
SSN/EIN 

 

State Setup / Employees 
Tax Withholding and Deduction tab 
State W/H Properties button 
State 
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ACE Write-Up 
Field Name 

CSA Menu Navigation 
CSA tab 
CSA Field Name 

Comments and additional information 

State Setup / Employees 
Other tab / SUTA G/L Accounts 
State 

 

 

Employee Earnings Balances 
See the section of this document entitled �Conversion Notes and Exceptions� regarding the conversion of employee earnings 
and withholding balances for current quarter and year-to-date. 
ACE Write-Up 
Field Name 

CSA Menu Navigation 
CSA tab 
CSA Field Name 

Comments and additional information 

Current Quarter 
Year to Date 
(user defined)  

Setup / Employees 
Earnings tab 
Wages 

 

Current Quarter 
Year to Date 
(user defined)  

Setup / Employees 
Earnings tab 
Salaried Wages 

 

Current Quarter 
Year to Date 
(user defined) 

Setup / Employees 
Earnings tab 
Overtime 

 

Current Quarter 
Year to Date 
(user defined) 

Setup / Employees 
Earnings tab 
Commissions 

 

Current Quarter 
Year to Date 
(user defined) 

Setup / Employees 
Earnings tab 
Bonus 

 

Current Quarter 
Year to Date 
(user defined) 

Setup / Employees 
Earnings tab 
Sick Pay 

 

Current Quarter 
Year to Date 
(user defined) 

Setup / Employees 
Earnings tab 
Vacation 

 

Current Quarter 
Year to Date 
(user defined) 

Setup / Employees 
Earnings tab 
Reported Tips 

 

Current Quarter 
Year to Date 
(user defined) 

Setup / Employees 
Earnings tab 
Other Wages 

 

Current Quarter 
Year to Date 
(user defined) 

Setup / Employees 
Tax Withholdings and Deductions 
tab 
FICA-SS 

 

Current Quarter 
Year to Date 
(user defined) 

Setup / Employees 
Tax Withholdings and Deductions 
tab 
FICA-Med 

 

Current Quarter 
Year to Date 
(user defined) 

Setup / Employees 
Tax Withholdings and Deductions 
tab 
Federal W/H 
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ACE Write-Up 
Field Name 

CSA Menu Navigation 
CSA tab 
CSA Field Name 

Comments and additional information 

Current Quarter 
Year to Date 
(user defined) 

Setup / Employees 
Tax Withholdings and Deductions 
tab 
State W/H 

 

Current Quarter 
Year to Date 
(user defined) 

Setup / Employees 
Tax Withholdings and Deductions 
tab 
Local W/H 

 

Current Quarter 
Year to Date 
(user defined) 

Setup / Employees 
Tax Withholdings and Deductions 
tab 
401K % of Gross 

 

Current Quarter 
Year to Date 
(user defined) 

Setup / Employees 
Tax Withholdings and Deductions 
tab 
Other Deductions 

 

Vendor Information 
ACE Write-Up 
Field Name 

CSA Menu Navigation 
CSA tab 
CSA Field Name 

Comments and additional information 

Vendor ID Setup / Vendors 
General tab 
Vendor ID 

 

Name 1 Setup / Vendors 
General tab 
Name 

The Name field in ACE Write-Up field is 25 characters long. 
In CSA, the Name field is 15 characters long. Only the first 
15 characters of the name will be converted 

Address Setup / Vendors 
General tab 
Street 

 

City Setup / Vendors 
General tab 
City 

 

State Setup / Vendors 
General tab 
State 

 

ZIP Code Setup / Vendors 
General tab 
Zip 

 

Federal ID#  Setup / Vendors 
General tab 
SSN 

 

Amounts Paid 
Current Year 

Setup / Vendors 
Distributions tab 
Year to date checks 

This amount represents the year-to-date checks paid to the 
vendor. It does not break the amounts up into 1099 type. If 
there are multiple 1099 type payments, you will need to 
break this information apart in CSA upon the completion of 
the conversion. 
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ITEMS NOT TRANSFERRED DURING CONVERSION 
OF DATA FROM ACE WRITE-UP 

Although most data from ACE Write-Up is converted, some data cannot be converted due to differences in program 
features and data structures between ACE Write-Up and CSA. The following items, which cannot be converted, are 
organized by screen in ACE Write-Up.  

General Client Information 
Client number, name, address, profit center type, statement type for chart setup as well as chart templates, entity type, 
history information. This information should be set up while adding the client to CSA. 

Budget Amounts 
Budget amounts for the last year, current year, 2nd year, 3rd year, and 4th year cannot be converted for ACE Write-Up 
clients. 

Payroll Transactions / Prior Employee Earnings Balances 
Although each payroll transaction is converted to each period�s G/L transactions screen, these transactions are not 
converted to the payroll checkbook. Therefore, no payroll transactions are converted for payroll purposes from ACE 
Write-Up to CSA. However current-quarter, and year-to-date earnings are converted to enable you to process W-2s and 
current-quarter payroll reports. Earnings for quarters other than the current quarter in the current fiscal year end cannot 
be converted. Likewise, earnings for prior years cannot be converted.  

Company Payroll Information 
Payroll codes for employees and employer, payroll report and report options, payroll defaults, and payroll forms cannot 
be converted. 

Journal Entry Information 
Journal codes and descriptions, automatic adjusting entry information such as payroll adjustments information, 
employer payroll adjustment information, gross profit adjustments information inventory adjustments, and all other 
setup information for automatic adjusting entries cannot be converted. 

Financial Statements  
Report formats, report details, notes, and transmittal letters cannot be converted. 

Employee Information 
Date hired, date terminated, marital status, exemptions, gross override, employer SS expense account, W2 markboxes, 
and W2 local code cannot be converted. 

Vendor Information 
Date hired, date terminated, marital status, exemptions, gross override, 1099 type and box number, W2 markboxes, W2 
local code, and YTD totals cannot be converted. 

Tax Line Assignments 
Tax line assignments in Ace Write-Up cannot be converted. The conversion will be unable to determine whether the tax 
line assignments entered in Ace Write-Up are for UltraTax or other tax software packages. 

Other Information / Add-On Modules 
Bank account reconciliation and write-file information cannot be converted. 
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CONVERSION NOTES AND EXCEPTIONS 
The following section details all known conversion exceptions between data from ACE Write-Up and the converted 
data in CSA. Conversion exceptions may include differences in field lengths between ACE Write-Up and CSA, required 
parsing of information from one field in ACE Write-Up to multiple fields in CSA, manipulation of ACE Write-Up data 
to conform with CSA requirements, and so on. 

CSA Combining Accounts 
ACE Write-Up profit centers are functionally similar to CSA departments, with one significant difference. CSA requires 
you to define �combining� accounts, which link individual department accounts and combine their amounts for 
reporting purposes. No transactions can be posted to the account and no balances need to be entered. These accounts 
are simply used to combine general balances for accounts that have already been posted to. For more information about 
setting up and using combining accounts, start the CSA program and search on �Combining accounts setup� in the 
Index tab of the CSA Help Topics dialog. 

Bank Rec Users 
If you are converting an ACE Write-Up client and will be using the Bank Reconciliation features within CSA, all 
transactions will convert into CSA as cleared transactions for the Bank Rec. Therefore if there are any transactions still 
outstanding at the time of conversion, you will need to enter them in the Initial Open Items dialog that is accessible 
from the Edit menu or F3 context menu when the Tasks / Bank Reconciliation window is active. 

Chart of Accounts 
The Chart of Accounts in CSA is similar in structure to the general ledger account mask in ACE Write-Up. However, 
there are some items that cannot be converted and a few differences that should be noted. 
• ACE general ledger account numbers included 3 digits to the right of the decimal point. These digits could be used 

for sub-accounts or to represent profit centers. You will have three options during the conversion process as noted 
below.  
1. If the 3 digits to the right of the decimal are subaccounts, leave both checkboxes unmarked in the Modify 

Account Numbers screen during the conversion. This account numbers will convert exactly as they appeared in 
ACE Write-Up. 

2. If the 3 digits to the right of the decimal point are not used, you can choose not to convert the zeros to CSA. 
For example, if you have account 11000.000 in ACE Write-Up, you can mark the Do not convert� checkbox 
in the Modify Account Numbers screen and this account will convert as 11000 in CSA, eliminating the zeros to 
the right of the decimal.  

3. If the 3 digits to the right of the decimal point are used to identify profit centers, you should mark the Profit 
Center � checkbox in the Modify Account Numbers screen.  If you wish to use departments in CSA, the 
department in the accounts mask must precede the core account number. Therefore, after the conversion has 
been completed, all digits (except zeros) to the right of the decimal will precede the core account number. 

• ACE allowed you to set up accounts for financial statement purposes as well as detail accounts. Accounts with a 
type code of t (total), h (header) or s (spacer) will not be converted to CSA. They are for financial statement 
formatting only. ACE general ledger accounts with a code d (detail) will be converted. 

• General ledger account information such as indentation code, space code, debit or credit code, total account code, 
underline code, dollar sign marker, SOCF code, and ledger code cannot be converted. This information will need 
to be set up in CSA during financial statement formatting. 

• After conversion, if you notice that all of the accounts in your chart converted as Assets, this is due to the existence 
of non-uniform accounts located at the end of the Chart of Accounts in ACE Write-Up. Example: Suppose that 
most accounts in your chart use four digits in front of the decimal and three after (09000.000). However, there are 
one or more accounts at the bottom of the chart that used five digits in front of the decimal and three after 
(12000.000). Having these non-uniform accounts in your chart does not allow the conversion wizard to truncate 
the leading zero on accounts like 09000.000 and thus prevents correct classification.  
To correct this issue:  In ACE Write-Up, choose Maintain / Chart of Accounts. Select each account that does not 
conform to your standard account number length and renumber it by choosing Edit / Change Account Number. 
These accounts can only be renumbered one at a time and should be renumbered to the standard length you are 
using for the rest of the chart of accounts. After completing these steps, re-run the conversion wizard, and convert 
the client to WS/W. 
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• After converting client data to WS/W, if the account balances for the equity or liability accounts are unexpectedly 
high, you need to address an issue involving duplicated balances. For example, assume the current period is June 
and the account balance for June has been duplicated in each period for the entire year. This issue occurs if the first 
number of the client�s Beginning of Income Statement account is the same as the first number of the equity 
accounts. The conversion program uses the Beginning of Income Statement account to determine where to stop 
calculating the change in balance for each period. In ACE, the balance for the balance sheet accounts is stored as 
the actual balance at the end of that period, and the balance for the income statement accounts is stored as the 
period balance change for each account.  
To correct this issue: Choose Maintain / Chart of Accounts in ACE Write-Up. From the Chart of Accounts 
window, choose Edit / Special Accounts and change the account number for the Beginning of Income Statement to 
the first account number with the same first number as the client�s income statement accounts. For example, if you 
use the 400s for equity account numbers and you use the 500s for revenue account numbers, choose the first 
account number that begins with a 5. After the Beginning of Income Statement account has been updated, re-run 
the conversion wizard, and convert the client to WS/W. 

Terminated Employees / Inactive Vendors 
Employees and vendors in ACE Write-Up are converted to CSA to complete W-2s or 1099s for the current year. The 
information converted from ACE Write-Up will include deleted or terminated employees, and after the conversion has 
been completed you will need to manually mark them as non-active in the CSA program. 
 
It should also be noted that if you deleted an employee and added a new employee in ACE using the deleted 
employee�s same ID, only one of those employee records can be converted. Furthermore, because there is no inactive 
date in Ace Write-Up to determine the difference, it is possible that the deleted employee�s records could be converted 
into CSA rather than those for the current employee with the same ID. Any records for current employees not converted 
as a result of this issue will need to be manually added to CSA along with their current-year wages. 

Employee Earnings and Withholding Balances 
During the conversion process, you will be presented with a payroll code translation screen, which will enable the ACE-
CSA Conversion Wizard to properly identify each ACE payroll balance and convert it to the proper CSA field (as listed 
in the Employee Balances section of this document). ACE allowed you to enter up to 18 gross pay or 
withholding/deduction items. The description you entered for each item in the Accumlator/Desc field will be presented 
in the ACE pay code translation screen. You will then be asked to match one of the CSA payroll types with the 
appropriate ACE pay code.  
 
Note: If you did not have separate gross pay accumulators and only used the GROSS to accumulate the gross pay, you 
should code the ACE code GROSS as salaried or hourly. 

VERIFYING YOUR CONVERTED DATA 
Although the conversion utility has been designed to convert your data as accurately as possible, there are some instances 
when the conversion may not convert all data correctly due to data corruption or other anomalies within the ACE Write-Up 
data. You should follow the steps below to verify that your ACE Write-Up data has been converted correctly. 

1. Start Creative Solutions Accounting and open the new client that was created.  
2. Make all necessary changes as noted in the �Conversion Notes and Exceptions� section of this document. 
3. In ACE Write-Up, print the Annual General Ledger and Trial Balance Working Report. 
4. In CSA, print the General Ledger and Trial Balance reports. 
5. Compare the reports. If the information contained on the ACE Write-Up reports does not match the CSA reports, 

you will need to determine what transaction(s) are invalid or missing and enter those transactions into CSA 
manually. Other reports are available in both systems if you cannot determine the discrepancy using the reports 
listed above. 

6. In ACE Write-Up, print the Payroll Employees Report. 
7. In CSA, print the Payroll Tax Summary Report. 
8. Compare the amounts on the ACE Write-Up and CSA payroll reports and note any discrepancies. You can make 

manual changes to any payroll amount in the CSA program. 
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If problems are encountered 
If problems are encountered during the conversion of client data from ACE Write-Up to your Creative Solutions 
Accounting software and you are unable to reconcile the data using the various reports and tools in CSA, contact CSI 
Product Support. 

SUPPORT 
Online Help 

For step-by-step procedures in the Creative Solutions Accounting software, refer to the online help. To learn how to use 
online help, choose Help / CSA Help Topics, click the Index tab, and search on �online help.� 

 
Web Site 

If you have questions or need assistance, you can visit our Web site at www.CreativeSolutions.com 24 hours a day for 
the latest information on current issues and processing tips. To take advantage of this convenient means of accessing 
information, choose CSI on the Web from the CSA Help menu, and then click Product Support and Service.  

 
Product Support 

To speak with a Product Support Representative, please call the CSI HelpLine at 800-968-0600, press 3 for accounting 
support, and then listen to the options available before pressing the number for Creative Solutions Accounting. Normal 
weekday support is from 9:00 AM to 8:00 PM Eastern Time.  

 

http://www.creativesolutions.com/
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